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NOTICES 

 

⚫ For in vitro diagnostic use only. 

⚫ Reliability of the results depends on adequate specimen collection, storage, transport, and 

processing procedure. 

⚫ This product is only for use with Microlab NIMBUS IVD, Microlab STARlet IVD, 

Seegene NIMBUS and Seegene STARlet maximum 5 separate runs. 

⚫ This test has been validated for the following specimen types: sputum, culture, fresh 

tissue, and bronchial washing. This test has not been validated for any other types of 

specimens. 

⚫ Store DNA samples at ≤-20°C until use and keep on ice during use. 

⚫ Sensitivity of the assay may decrease if samples are repeatedly frozen/thawed or stored for 

a longer period of time. 

⚫ Workflow in the laboratory should proceed in a unidirectional manner. 

⚫ Always wear disposable gloves in each area and change them before entering different 

areas. Change gloves immediately if contaminated or treat them with DNA decontaminating 

reagent. 

⚫ Dedicate supplies and equipment to separate working areas and do not move them from 

one area to another. 

⚫ Do not pipette by mouth. 

⚫ Do not eat, drink, or smoke in laboratory work areas. Wear disposable powder-free gloves, 

laboratory coats, and eye protections when handling specimens and reagents. Wash hands 

thoroughly after handling specimens and test reagents. 

⚫ Avoid contamination of reagents when removing aliquots from reagent tubes. The use of 

sterile disposable pipette tips is recommended. 

⚫ Do not pool reagents from different lots or from different tubes of the same lot. 

⚫ Do not use a product after its expiry date. 

⚫ All disposable items are for one time use. Do not reuse. 

⚫ Use screw-capped tubes and prevent any potential splashing or cross-contamination of 

specimens during preparation. 

⚫ Please be careful not to contaminate reagents with extracted nucleic acids, PCR products, 

and Positive Control. To prevent contamination of the reagents, use of filter tips is 

recommended. 

⚫ Use separated and segregated working areas for each experiment. 
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⚫ To avoid contamination of working areas with amplified products, open PCR reaction tubes 

or strips only at designated working areas after amplification. 

⚫ Store positive materials separated from the kit’s reagents. 

⚫ Laboratory safety procedures (refer to Biosafety in Microbiological and Biomedical 

Laboratories & CLSI Documents) must be taken when handling specimens. Thoroughly 

clean and disinfect all work surfaces with 0.5% sodium hypochlorite (in deionized or distilled 

water). Product components (product residuals, packaging) can be considered as laboratory 

waste. Dispose of unused reagents and waste in accordance with applicable federal, state, 

and local regulations. 

⚫ Expiry date is 12 months at ≤ -20℃ from the date of manufacture. Please refer to label for 

final expiry date. 

⚫ Seegene NIMBUS and Seegene STARlet are the same equipment as the Microlab NIMBUS 

IVD and Microlab STARlet IVD, although the manufacturer is different. Since there are no 

hardware changes on the device, the test results are the same. 

⚫ The brand name of “CFX96™ Real-time PCR Detection System-IVD” is changed to 

“CFX96™ Dx System”. Since there are no hardware changes to the systems, it is expected 

to obtain the same results from both systems. 

⚫ “CFX Manager™ Dx Software v3.1” is an upgrade version of “CFX Manager™ Software-

IVD v1.6”. The upgraded software includes enhancements to the “Run” menu. These 

enhancements do not impact the results of data analysis; therefore, results will be the 

same. 

⚫ This kit is intended to aid in the differential diagnosis of target pathogen infections;  

Mycobacterium tuberculosis and non-tuberculosis mycobacteria. 
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INTENDED USE 

 

AnyplexTM MTB/NTM Real-time Detection (V2.0) is a qualitative in vitro test for detection of 

Mycobacterium tuberculosis (MTB) and non-tuberculosis mycobacteria (NTM) from sputum, 

culture (solid culture and liquid culture), fresh tissue, and bronchial washing of symptomatic 

patients. 

AnyplexTM MTB/NTM Real-time Detection (V2.0) does not differentiate among members of the 

M. tuberculosis complex, i.e., M. tuberculosis, M. bovis, M. bovis BCG, M. africanum, M. microti, 

M. canetti, and M. pinnipedii. 

 

 

PRINCIPLES AND PROCEDURE OVERVIEW 

 

1.  Principles 

 

The polymerase chain reaction (PCR) DNA amplification technique is highly sensitive and 

specific. Seegene developed a proprietary oligo technology called “Dual Priming 

Oligonucleotide (DPOTM)”, which provides freedom in primer design and PCR optimization and 

maximizes PCR specificity and sensitivity by fundamentally blocking non-specific priming. 

AnyplexTM MTB/NTM Real-time Detection (V2.0) is based on two major processes: nucleic acid 

extraction and PCR amplification of target nucleic acid using DPO primers with real-time PCR 

machine. AnyplexTM MTB/NTM Real-time Detection (V2.0) is a multiplex real time PCR assay 

that permits amplification of target nucleic acids of M. tuberculosis (MTB), mycobacteria and 

Internal Control (IC).  

The Internal Control is added to AnyplexTM MTB/NTM Real-time Detection (V2.0) to identify 

processed specimens containing substances that may interfere with PCR amplification. The 

Internal Control is a DNA plasmid. These features are selected to ensure equivalent 

amplification of the Internal Control, MTB and mycobacteria target DNA. The Internal Control is 

introduced into each amplification reaction and co-amplified with target DNA from the clinical 

specimen. 

To prevent amplification product acting as potential contaminants, Uracil-DNA glycosylase 

(UDG)-dUTP system is employed in AnyplexTM MTB/NTM Real-time Detection (V2.0). The 

natural function of UDG is to prevent mutagenesis by eliminating uracil from DNA molecules by 

cleaving N-glycosylic bond and initialting base-excision repair (BER) pathway. Therefore, UDG 

systems are used to control cross-contamination of samples with amplicons. 
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2.  Procedure Overview 

 

 

 

 

  

Analysis of results 

Nucleic acid 

 

Samples 

(Sputum, culture, fresh tissue, or 

 bronchial washing) 

 

Amplification and 

detection using 

AnyplexTM system 

Nucleic acid extraction 
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BACKGROUND INFORMATION 

 

The rapid and accurate diagnosis of symptomatic patients is the cornerstone of global 

strategies for tuberculosis (TB) control. The advantages and limitations of each available TB 

diagnostic method are evident and no test is yet available that meets target specificity. 

Furthermore, the quality of the test results with existing methods is dependent on the availability 

of sufficient human and financial resources, training of laboratory personnel and monitoring of 

performance. 

Active tuberculosis is currently diagnosed using an assortment of techniques, symptoms, and 

clinical signs. These techniques include the X-ray, microscopy (after AFB staining), culture, and 

molecular diagnostics. The current gold standard is culture. Although effective implementation 

of current techniques can substantially reduce the time needed, the physician planning 

treatment for a suspected tuberculosis patient vitally needs this diagnostic information. In the 

past, delays in obtaining this information were thought to be acceptable. But this is no longer 

true. The rapid progress of the disease in HIV-infected individuals and the continued 

emergence of drug-resistant diseases underscore the need for new rapid and sensitive 

diagnostics. 
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REAGENTS 

 

The reagents contained in one kit are sufficient for 100 reactions. 

Order information (        TB7200X) 

 

AnyplexTM MTB/NTM Real-time Detection (V2.0) 

Symbol Contents Volume Description 

 

10X MTB/NTM 

OM 
200 μL 

Oligo Mix (OM): 

➢ Amplification and detection reagents 

➢ Template of Internal Control 

 
EM3 1,000 μL 

➢ DNA polymerase 

➢ Uracil-DNA glycosylase (UDG) 

➢ Buffer containing dNTPs 

 
MTB/NTM PC 50 μL 

Positive Control (PC): 

➢ Mixture of pathogen and IC clones 

 

RNase-free 

Water 
1,000 μL Ultrapure quality, PCR-grade 

 

DNA Extraction 

Solution 
10 mL X 2 Reagent for bacterial DNA extraction 

 
User manual 
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STORAGE AND HANDLING 

 

All components of AnyplexTM MTB/NTM Real-time Detection (V2.0) should be stored at 

≤ -20°C. All components are stable under recommended storage conditions until the expiry date 

stated on the label. The performance of kit components is not affected for up to 5 freezing and 

thawing. If the reagents are to be used only intermittently, they should be stored in aliquots. 

 

 

MATERIALS REQUIRED BUT NOT PROVIDED 

 

⚫ NALC-NaOH (0.5% NALC, 2% NaOH, 1.47% trisodium citrate) or 4% NaOH (1N NaOH) 

⚫ 1X PBS solution 

⚫ Disposable powder free gloves (latex or nitrile) 

⚫ Pipettes (adjustable) and sterile pipette tips 

⚫ 1.5mL microcentrifuge tubes 

⚫ Ice maker 

⚫ Heat block 

⚫ Desktop centrifuge 

⚫ Vortex mixer 

⚫ Clean bench 

⚫ CFX96TM Real-time PCR Detection System (Bio-Rad) 

⚫ CFX96TM Dx System (Bio-Rad) 

⚫ Low-Profile 0.2 mL 8-Tube Strips without Caps (white color, Cat. No. TLS0851, Bio-Rad) 

⚫ Optical Flat 8-Cap Strips (Cat. No. TCS0803, Bio-Rad) 

⚫ EU 0.1 mL, Thin-wall 8-tube Strip, white (Cat. No. B77009; BIOplastics) 

⚫ EU 8-single attachable optical wide indented cap-strip (Cat. No. B79501; BIOplastics) 

⚫ 7500 Real-time PCR System, Software v2.0.5 (Life Technologies) 

⚫ MicroAmp®  Optical 8-Tube Strip (0.2 mL) (Part No. 4316567, Life Technologies) 

⚫ MicroAmp®  Optical 8-Cap Strip (Part No. 4323032, Life Technologies) 
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PROTOCOL 

 

1.  Specimen Collection, Storage, and Transport 

 

Note: All samples should be treated as potentially infectious materials. Only those sample 

materials are permitted, which are collected, stored and transported attending strictly the 

following rules and instructions.  

Note: To ensure high sample quality, specimens should be transported as fast as possible. 

The specimens should be transported at indicated temperatures. 

 

A.  Specimen Collection 

 

Sputum 

⚫ Give clear instructions to patients when collecting sputum specimens. Patients must 

collect samples either outside in the open air or away from other people. Patients should 

not collect samples in confined spaces such as toilets. 

⚫ Rinse mouth with water before collecting sputum. Patients should cough deeply to 

expectorate sputum directly into the container. 

⚫ A sputum sample must have a volume of 3~5 mL. 

 

Solid culture (Ogawa) 

⚫ Samples may be tested as soon as growth is visible and during the subsequent 60 days of 

incubation. 

⚫ Colony can be collected with a disposable plastic loop or needle. Avoid collecting any of 

the Ogawa media along with the cell. 

 

Liquid culture (MGIT) 

⚫ Mycobacterial growth indicator tubes (MGITs) are examined daily with a UV lamp for bright 

orange fluorescence at the bottom of the tube reflected at the meniscus. With the positive 

signal of fluorescence, pipette a 0.5 mL of sample from the bottom of the tube. 

 

Fresh tissue 

⚫ Any tissue to be tested must be collected aseptically into a sterile container without 

fixatives or preservatives. Do not place tissue specimen for culture into formalin. 

⚫ If the specimen dries, add sterile saline to keep moist. Keep refrigerated until transport. 
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Bronchial washing 

⚫ Bronchial washing should be aseptically collected in a sterile container by the physician 

using aspiration techniques or surgical procedures. 

 

B.  Specimen Storage and Transport 

Specimen 
Storage and Transport 

Note 
Temp. Duration* 

Sputum 

2~8°C 3 days 

- Performance may be affected by 

prolonged storage of specimens. 

- Specimens should also adhere to 

local and national instructions for 

transport of pathogenic material. 

Solid culture (Ogawa) 

Liquid culture (MGIT) 

Fresh tissue 

Bronchial washing 
 

* Duration: The time period from the specimen collection to the final test (includes transport 
and storage of specimens in prior to test). 

 

 

2.  Pretreatment of Specimens 

 

Sputum 

 

1) For Manual Nucleic Acid Extraction 

⚫ Add same volume of NALC-NaOH (0.5% NALC, 2% NaOH, and 1.47% trisodium citrate) 

to the specimen in the sputum container and vortex for 1 minute. 

Note: 4% NaOH (1 N NaOH) can be used instead of NALC-NaOH. 

 

⚫ Incubate for 15 minutes at room temperature. 

⚫ Transfer 1.5 mL to a new sterile tube and centrifuge at 15,000 x g (13,000 rpm) for 5 

minutes. 

⚫ Discard supernatant, add 1 mL of 1X PBS solution, and mix well. 

⚫ Centrifuge at 15,000 x g (13,000 rpm) for 5 minutes and discard supernatant with a 

pipette. 

⚫ Add 1 mL of 1X PBS solution and mix well. 

⚫ Centrifuge at 15,000 x g (13,000 rpm) for 5 minutes and discard supernatant with a 

pipette. 
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2) For Automated Nucleic Acid Extraction System 

⚫ Add same volume of NALC-NaOH (0.5% NALC, 2% NaOH, and 1.47% trisodium citrate) 

to the specimen in the sputum container and vortex for 1 minute. 

⚫ Incubate for 15 minutes at room temperature. 

⚫ Transfer 1 mL to a new sterile tube and centrifuge at 15,000 x g (13,000 rpm) for 5 

minutes. 

⚫ Discard supernatant, add 300 μL Lysis Buffer of Universal kit to the pellet, and mix well.  

⚫ Lock the tube cap using a cap-lock and boil for 5 minutes on heat block. 

 

Fresh tissue 

⚫ Cut or grind tissue specimen in a sterile vessel. 

⚫ Suspend in 1 mL of 1X PBS solution. 

⚫ Centrifuge at 15,000 x g (13,000 rpm) for 5 minutes and discard supernatant with a 

pipette. 

 

Bronchial washing 

⚫ Without adding NALC-NaOH, centrifuge 1.5 mL of specimen at 15,000 x g (13,000 rpm) 

for 5 minutes. 

⚫ Discard supernatant, add 1 mL of 1X PBS solution, and mix well. 

⚫ Centrifuge at 15,000 x g (13,000 rpm) for 5 minutes and discard supernatant with a 

pipette. 

 

3.  Nucleic Acid Extraction 

 

A. Manual Nucleic Acid Extraction Kits 

 

DNA Extraction Solution is included in Anyplex™ MTB/NTM Real-time Detection (V2.0) kit. 

All specimens except culture samples 

⚫ (Optional) Add 1 mL of sterile water to the prepared sediment, centrifuge at 15,000 x g 

(13,000 rpm) for 5 minutes, and discard supernatant with a pipette. 

⚫ Add 100 μL of DNA Extraction Solution to the sediment and vortex for 30 seconds. 

⚫ Lock the tube cap using a cap-lock and boil at 100°C for 20 minutes on heat block. 

⚫ Centrifuge at 15,000 x g (13,000 rpm) for 5 minutes. 

⚫ Use 5 μL of supernatant as PCR template. 
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Solid culture (Ogawa) 

⚫ Suspend a colony in 200 μL of DNA Extraction Solution in a 1.5 mL microcentrifuge tube. 

⚫ Vortex for 30 seconds. 

⚫ Lock the tube cap using a cap-lock and boil at 100°C for 20 minutes on heat block. 

⚫ Centrifuge at 15,000 x g (13,000 rpm) for 5 minutes. 

⚫ Use 5 μL of supernatant as PCR template. 

 

Liquid culture (MGIT) 

⚫ Transfer 0.5 mL of the culture at the bottom to a 1.5 mL microcentrifuge tube. 

⚫ Centrifuge at 15,000 x g (13,000 rpm) for 5 minutes. 

⚫ Discard supernatant and add 200 μL of DNA Extraction Solution to the pellet. 

⚫ Vortex for 30 seconds. 

⚫ Lock the tube cap using a cap-lock and boil at 100°C for 20 minutes on heat block. 

⚫ Centrifuge at 15,000 x g (13,000 rpm) for 5 minutes. 

⚫ Use 5 μL of supernatant as PCR template. 

 

B. Automated Nucleic Acid Extraction System 

 

Note: Microlab NIMBUS IVD, Microlab STARlet IVD, Seegene NIMBUS and Seegene STARlet 

have been validated for only sputum. 

Note: Please use the recommended specimen and elution volumes as indicated below. For all 

others, refer to the manufacturer’s protocol. 

 

B-1. Microlab NIMBUS IVD 

 

Note: See Microlab NIMBUS IVD operation manual. 

Automated Extraction System Manufacturer Cat. No. Recommended Vol. 

Microlab NIMBUS IVD Hamilton 65415-02* - 

STARMag 96 X 4 Universal Cartridge 

Kit 
Seegene 

744300.4. 

UC384 

Specimen: 300 μL 

Elution: 100 μL 
 

* If you would like to purchase this product from Seegene Inc., please use this catalog number. 
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B-2. Microlab STARlet IVD 

 

Note: See Microlab STARlet IVD operation manual. 

Automated Extraction System Manufacturer Cat. No. Recommended Vol. 

Microlab STARlet IVD Hamilton 173000-075* - 

STARMag 96 X 4 Universal Cartridge 

Kit 
Seegene 

744300.4. 

UC384 

Specimen: 300 μL 

Elution: 100 μL 
 

* If you would like to purchase this product from Seegene Inc., please use this catalog number. 

 

B-3. Seegene NIMBUS 

 

Note: See Seegene NIMBUS operation manual. 

Automated Extraction System Manufacturer Cat. No. Recommended Vol. 

Seegene NIMBUS Seegene 65415-03 - 

STARMag 96 X 4 Universal Cartridge 

Kit 
Seegene 

744300.4. 

UC384 

Specimen: 300 μL 

Elution: 100 μL 
 

 

B-4. Seegene STARlet 

 

Note: See Seegene STARlet operation manual. 

Automated Extraction System Manufacturer Cat. No. Recommended Vol. 

Seegene STARlet Seegene 67930-03 - 

STARMag 96 X 4 Universal Cartridge 

Kit 
Seegene 

744300.4. 

UC384 

Specimen: 300 μL 

Elution: 100 μL 
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4.  Preparation for Real-time PCR 

 

Note: The correct tubes and caps must be used (see MATERIALS REQUIRED BUT NOT 

PROVIDED). 

Note: Aerosol-resistant filter tips and tight gloves must be used when preparing PCR reactions. 

Use extreme care to prevent cross-contamination. 

Note: Completely thaw all reagents on ice. 

Note: Briefly centrifuge the reagent tubes to remove droplets from the inside of the cap. 

Note: The steps A~D are automatically processed on Microlab NIMBUS IVD, Microlab 

STARlet IVD, Seegene NIMBUS and Seegene STARlet. Refer to each operation manual. 

 

A.  Prepare PCR Mastermix.  

2 μL 10X MTB/NTM OM 

3 μL RNase-free Water 

10 μL EM3 

15 μL Total volume of PCR Mastermix 

 

Note: Calculate the necessary volume of each reagent needed based on the number of 

reactions (samples + controls). 

 

B.  Mix by inverting the tube 5 times or quick vortex, and briefly centrifuge. 

C.  Aliquot 15 μL of the PCR Mastermix into 0.2-mL PCR tubes. 

D.  Add 5 μL of each sample’s nucleic acids into the tube containing PCR Mastermix. 

15 μL PCR Mastermix 

5 μL Sample’s nucleic acid  

20 μL Total volume of reaction 

 

E.  Close the cap, and briefly centrifuge the PCR tubes. 

F.  Verify that the liquid containing all PCR components is at the bottom of each PCR tube. If 

not, centrifuge again at a higher rpm for a longer time. 
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Note: It is recommended to centrifuge PCR tubes before PCR to eliminate air bubbles 

and collect all residual liquids at the bottom of tubes. 

Correct Incorrect 

  

 

Note: Use a new sterile pipette tip for each sample. 

Note: For Negative Control (NC), use 5 μL of RNase-free Water instead of sample’s nucleic 

acid.  

Note: For Positive Control (PC), use 5 μL of MTB/NTM PC instead of sample’s nucleic acid.   

Note: Please be careful not to cross contaminate the PCR Mastermix and samples with   

Positive Control. 

Note: Do not label the cap of the reaction tubes as fluorescence is detected from the top of the 

cap. 
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REAL-TIME PCR INSTRUMENT SET UP AND RESULTS ANALYSIS 

 

1. CFX96TM Real-time PCR Detection System (CFX ManagerTM Software-IVD v1.6)  

 

1.1.  Real-time PCR Instrument set up 

 

Note: CFX96TM Real-time PCR Detection System (Bio-Rad) experiment setup is divided into 

three steps: Protocol Setup, Plate Setup, and Start run. 

      

A. Protocol Setup 

 

1) In the main menu, select File→New→Protocol to open Protocol Editor.  

 

Fig. 1. Protocol Setup. Create a new protocol or load an existing protocol for the run 

 

2) In Protocol Editor, define the thermal profile as follows: 

Step No. of cycles Temperature Duration 

1 1 95°C 15 min 

2 
45 

95°C 30 sec 

3* 60°C  1 min 

4 GOTO Step 2, 44 more times 

* Plate Read at Step 3. Fluorescence is detected at 60°C. 

 



  

 
18                                                                06/2021 V3.07 

 
AnyplexTM MTB/NTM Real-time Detection (V2.0)  

 

 

Fig. 2. Protocol Editor 

 

3)  Click the box next to Sample Volume to directly input 20 μL. 

4)  Click OK and save the protocol to open Experiment Setup window.  

 

Fig. 3. Experiment Setup: Protocol 
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B. Plate Setup 

 

1)  From Plate tab in Experiment Setup, click Create New to open Plate Editor window. 

 

Fig. 4. Plate Editor. Create a new plate 

 

2)  Click Select Fluorophores to indicate the fluorophores (FAM, Cal Red 610 and Quasar 

670) that will be used and click OK. 

 

Fig. 5. Select Fluorophores (FAM, Cal Red 610 and Quasar 670) 
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3)  Select the wells where the PCR tube will be placed and select its sample type from the 

Sample Type drop-down menu. 

   - Unknown: Clinical samples 

   - Negative Control  

   - Positive Control  

 

4)  Click on the appropriate checkboxes (FAM, Cal Red 610 and Quasar 670) to specify the 

fluorophores to be detected in the selected wells. 

5)  Type in Sample Name and press enter key. 

6)  In Settings of the Plate Editor main menu, choose Plate Size (96 wells) and Plate Type 

(BR White).  

 

Fig. 6. Plate Setup 

 

7)  Click OK to save the new plate. 

8)  You will be returned to the Experiment Setup window. 
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Fig. 7. Experiment Setup: Plate 

 

9)  Click Next to Start Run. 

 

C. Start Run 

 

1)  From Start Run tab in Experiment Setup, click Close Lid to close the instrument lid.  

 

Fig. 8. Close Lid 
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2)  Click Start Run. 

3)  Store the run file either in My Documents or in a designated folder. Input the file name, click 

SAVE, and then the run will start. 

 

1.2.  Pre-settings for Data Analysis in CFX Manager™ 

 

A.  Pre-settings 

 

Note: Check the setting of Single Threshold and Baseline Subtracted Curve Fit. 

  

Fig. 9. Single Threshold 
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Fig. 10. Baseline Subtracted Curve Fit 

 

B.  Baseline Threshold 

B-1.  Baseline Threshold for Bio-Rad tube 

Note: Set the Single Threshold of Baseline Threshold.  

Note: For the setting of Baseline Threshold, you must select the FAM, Cal Red 610, and 

Quasar 670 signal separately. 

 

Fig. 11. Checking of Baseline Threshold. Click the right button of mouse on graph 
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Note: Set the Baseline Cycles as Auto Calculated. 

Note: Set the Single Threshold value for each fluorophore as follows: 

Analyte Fluorophore Threshold value 

MTB FAM 500 

Mycobacteria Cal Red 610 500 

Internal Control Quasar 670 60 

 

 

Fig. 12. Setting of Single Threshold value. Click User Defined button and change the Single 

Threshold value 

 

B-2.  Baseline Threshold for BIOplastics tube 

 

Note: Set the Single Threshold of Baseline Threshold.  

Note: For the setting of Baseline Threshold, you must select the FAM, Cal Red 610, and 

Quasar 670 signal separately. 
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Fig. 13. Checking of Baseline Threshold. Click the right button of mouse on graph 

   

Note: Set the Baseline Cycles as follows: Begin: 3, End: 10 

 

Fig. 14. Setting of Baseline Cycles. Click User Defined button and change the Baseline Cycles 
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Note: Set the Single Threshold value for each fluorophore as follows: 

Analyte Fluorophore Threshold value 

MTB FAM 1200 

Mycobacteria Cal Red 610 1000 

Internal Control Quasar 670 100 

 

 

Fig. 15. Setting of Single Threshold value. Click User Defined button and change the Single 

Threshold value 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



  

 
27                                                                06/2021 V3.07 

 
AnyplexTM MTB/NTM Real-time Detection (V2.0)  

 

2. CFX96TM Dx System (CFX ManagerTM Dx Software v3.1) 

 

2.1. Real-time PCR Instrument set up 

 

Note: CFX96TM Dx System (Bio-Rad) experiment setup is divided into three steps: Protocol 

Setup, Plate Setup, and Start run. 

      

A.  Protocol Setup 

 

1)  In the main menu, select File→New→Protocol to open Protocol Editor.  

 

Fig. 1. Protocol Setup. Create a new protocol or load an existing protocol for the run 

 

2) In Protocol Editor, define the thermal profile as follows: 

Step No. of cycles Temperature Duration 

1 1 95°C 15 min 

2 
45 

95°C 30 sec 

3* 60°C  1 min 

4 GOTO Step 2, 44 more times 

* Plate Read at Step 3. Fluorescence is detected at 60°C. 
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Fig. 2. Protocol Editor 

 

3)  Click the box next to Sample Volume to directly input 20 μL. 

4)  Click OK and save the protocol to open Run Setup window.  

  

Fig. 3. Run Setup: Protocol 
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B.  Plate Setup 

 

1)  From Plate tab in Run Setup, click Create New to open Plate Editor window. 

 

Fig. 4. Plate Editor. Create a new plate 

 

2)  Click Select Fluorophores to indicate the fluorophores (FAM, Cal Red 610 and Quasar 

670) that will be used and click OK. 

 

Fig. 5. Select Fluorophores (FAM, Cal Red 610 and Quasar 670) 
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3)  Select the wells where the PCR tube will be placed and select its sample type from the 

Sample Type drop-down menu. 

   - Unknown: Clinical samples 

   - Negative Control  

   - Positive Control  

 

4)  Click on the appropriate checkboxes (FAM, Cal Red 610 and Quasar 670) to specify the 

fluorophores to be detected in the selected wells. 

5)  Type in Sample Name and press enter key. 

6)  In Settings of the Plate Editor main menu, choose Plate Size (96 wells) and Plate Type 

(BR White).  

 

Fig. 6. Plate Setup 

 

7)  Click OK to save the new plate. 

8)  You will be returned to the Run Setup window. 
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Fig. 7. Run Setup: Plate 

 

9)  Click Next to Start Run. 

 

C.  Start Run 

 

1)  From Start Run tab in Run Setup, click Close Lid to close the instrument lid.  

 

Fig. 8. Close Lid 
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2)  Click Start Run. 

3)  Store the run file either in My Documents or in a designated folder. Input the file name, click 

SAVE, and then the run will start. 

 

2.2.  Pre-settings for Data Analysis in CFX Manager™ 

 

A.  Pre-settings 

 

Note: Check the setting of Single Threshold and Baseline Subtracted Curve Fit. 

  

Fig. 9. Single Threshold 
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Fig. 10. Baseline Subtracted Curve Fit 

 

B.  Baseline Threshold 

B-1.  Baseline Threshold for Bio-Rad tube 

Note: Set the Single Threshold of Baseline Threshold.  

Note: For the setting of Baseline Threshold, you must select the FAM, Cal Red 610, and 

Quasar 670 signal separately. 

  

Fig. 11. Checking of Baseline Threshold. Click the right button of mouse on graph 
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Note: Set the Baseline Cycles as Auto Calculated. 

Note: Set the Single Threshold value for each fluorophore as follows: 

Analyte Fluorophore Threshold value 

MTB FAM 500 

Mycobacteria Cal Red 610 500 

Internal Control Quasar 670 60 

 

  

Fig. 12. Setting of Single Threshold value. Click User Defined button and change the Single 

Threshold value 

 

B-2.  Baseline Threshold for BIOplastics tube 

 

Note: Set the Single Threshold of Baseline Threshold.  

Note: For the setting of Baseline Threshold, you must select the FAM, Cal Red 610, and 

Quasar 670 signal separately. 
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Fig. 13. Checking of Baseline Threshold. Click the right button of mouse on graph 

   

Note: Set the Baseline Cycles as follows: Begin: 3, End: 10 

 

Fig. 14. Setting of Baseline Cycles. Click User Defined button and change the Baseline Cycles 
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Note: Set the Single Threshold value for each fluorophore as follows: 

Analyte Fluorophore Threshold value 

MTB FAM 1200 

Mycobacteria Cal Red 610 1000 

Internal Control Quasar 670 100 

 

 

Fig. 15. Setting of Single Threshold value. Click User Defined button and change the Single 

Threshold value 
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3.  7500 Real-time PCR System, Software v2.0.5 (Life Technologies) 

 

3.1.  Real-time PCR Instrument set up 

 

Note: Instructions provided for the 7500 Real-time PCR Instrument, Software v2.0.5. 

Note: The 7500 Real-time PCR System (Life Technologies) experiment setup program for the 

detection of MTB, mycobacteria and Internal control can be divided into following steps:  

Experiment Properties Set Up, Plate Set Up, and Run Method Set Up 

 

A.  Experiment Properties Set Up 

 

1)  In the program home, select Advanced Setup icon. 

 

Fig. 1. Create new document 

 

2)  Set Experiment Properties of the new experiment in Experiment Menu. 

- Experiment Name : Enter an experiment name. 

- Instrument Type : 7500 (96 Wells) 

- Type of experiment to set up : Quantitation - Standard Curve 

- Reagents to detection : TaqMan® Reagents 

- Run Mode : Standard 
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Fig. 2. Set Properties of the New Experiment 

 

B.  Plate Set Up 

 

1)  In Experiment Menu, click Plate Setup. 

2)  Define Targets: Click Add New Target as needed.  

3)  Enter an each Target Name.  

4)  Select Reporter and Quencher for the targets as follows: 

Target Name Reporter Quencher 

MTB FAM 

None Mycobacteria ROX 

Internal Control CY5 
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Fig. 3. Select detector 

 

5)  In Assign Targets and Samples tab of Plate Setup, select the wells you want to load.  

6)  Assign Targets to the selected wells. 

7)  Select the dye to use as the passive reference to ‘None’. 

 

Fig. 4. Assign Targets 

 

C.  Run Method Set Up 

1)  In Experiment Menu, click Run Method. 

2)  Input a reaction volume: 20 (μL). 

3)  Set a thermal profile as follows: 

 

 

 



  

 
40                                                                06/2021 V3.07 

 
AnyplexTM MTB/NTM Real-time Detection (V2.0)  

 

 Step No. of cycles Temperature Duration 

Holding Stage 1 1 95°C 15 min 

Cycling Stage 
1 

45 
95°C 30 sec 

2 60°C  1 min 

Note: Click Data Collection On at Step 2 of Cycling Stage. Reporter is detected at 60°C. 

Note: Uncheck Enable AutoDelta. 

 

4)  Click Start Run button. 

 

Fig. 5. Set up Run Method 

 

3.2  Pre-settings for Data Analysis 

 

A.  Pre-settings 

 

1)  In Analysis of the Experiment Menu, click Amplification Plot. 

2)  Select Plot Type (∆Rn vs Cycle) and Graph Type (Linear) in Plot Settings tab. 

3)  Set the threshold value for each target in Options tab.  

4)  Refer to the threshold value for each target as follows: 

Analyte Reporter Threshold Value 

MTB  FAM 5.0e+004 

Mycobacteria ROX 5.0e+004 

Internal Control  CY5 5.0e+003 
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Note: For the setting of threshold value, you must analyze the FAM signal, ROX signal, and 

CY5 signal separately. 

 

Fig. 6. Analysis settings 

 

5)  Select Auto Baseline. 

6)  Click Analyze button. 
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RESULTS  

 

1.  CFX96TM Real-time PCR Detection System (Bio-Rad)  / CFX96TM Dx System (Bio-Rad) 

 

1.1.  Interpretation of Results 

 

Analyte Fluorophore 
Sample / Negative Control Positive Control 

Ct value Result Ct value Result 

MTB FAM 

< 40   Positive (+) < 25   Valid 

≥ 40 

N/A 
Negative (-) 

≥ 25 

N/A 
Invalid 

Mycobacteria  Cal Red 610 

< 38 Positive (+) < 25   Valid 

≥ 38 

N/A 
Negative (-) 

≥ 25 

N/A 
Invalid 

Internal  

Control 
Quasar 670 

< 35 Positive (+) < 25   Valid 

≥ 35 

N/A 
Negative (-) 

≥ 25 

N/A 
Invalid 
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Result 

Interpretation Quasar 670 

(IC) 

FAM 

(MTB) 

Cal Red 610 

(Mycobacteria) 

Case 1 

+ 

+ + 

MTB : Detected 

Mycobacteria : Detected 
MTB 

Ct value of Mycobacteria  

< Ct value of MTB  

MTB&NTM  

co-infection 

Case 2 + - 
MTB : Detected 

Mycobacteria : Not detected 
MTB 

Case 3 - + 
MTB : Not detected 

Mycobacteria : Detected 
NTM 

Case 4 - - 
MTB : Not detected 

Mycobacteria : Not detected 
Negative 

Case 5 

- 

+ + 

MTB : Detected 

Mycobacteria : Detected 
MTB* 

Ct value of Mycobacteria  

< Ct value of MTB  

MTB&NTM  

co-infection* 

Case 6 + - 
MTB : Detected 

Mycobacteria : Not detected 
MTB* 

Case 7 - + 
MTB : Not detected 

Mycobacteria : Detected 
NTM* 

Case 8 - - 
MTB : Not detected 

Mycobacteria : Not detected 
Invalid ** 

 

*  PCR reaction has been inhibited. The result is still valid. 

** For invalid specimen results, pathogen nucleic acid, if present, would not be 

detectable. Process another aliquot of the original specimen and repeat the test. 

Inhibitors are often labile and specimens initially inhibitory may not be inhibited when 

repeated. If the original specimen is not available, 10~100 fold dilution of the template 

nucleic acid in distilled water may improve the PCR result.  
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1.2.  Application to Clinical Samples  

 

Sample1  

CFX96TM Seegene Viewer 

  

Fluorophore Ct value Result 

FAM 20.81 

MTB Cal Red 610 25.84 

Quasar 670 33.60 
 

 

  

Sample2  

CFX96TM Seegene Viewer 

  

Fluorophore Ct value Result 

FAM N/A 

NTM Cal Red 610 31.33 

Quasar 670 34.38 
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2.  7500 Real-time PCR System (Life Technologies) 

 

2.1.  Interpretation of Results 

 

Analyte Reporter 
Sample / Negative Control Positive Control 

Ct value Result Ct value Result 

MTB FAM 

< 40   Positive (+) < 25   Valid 

≥ 40 

Undet. 
Negative (-) 

≥ 25 

Undet. 
Invalid 

Mycobacteria  ROX 

< 38 Positive (+) < 25   Valid 

≥ 38 

Undet. 
Negative (-) 

≥ 25 

Undet. 
Invalid 

Internal  

Control 
CY5 

< 35 Positive (+) < 25   Valid 

≥ 35 

Undet. 
Negative (-) 

≥ 25 

Undet. 
Invalid 
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Result 

Interpretation CY5 

(IC) 

FAM 

(MTB) 

ROX 

(Mycobacteria) 

Case 1 

+ 

+ + 

MTB : Detected 

Mycobacteria : Detected 
MTB 

Ct value of Mycobacteria  

< Ct value of MTB  

MTB&NTM  

co-infection 

Case 2 + - 
MTB : Detected 

Mycobacteria : Not detected 
MTB 

Case 3 - + 
MTB : Not detected 

Mycobacteria : Detected 
NTM 

Case 4 - - 
MTB : Not detected 

Mycobacteria : Not detected 
Negative 

Case 5 

- 

+ + 

MTB : Detected 

Mycobacteria : Detected 
MTB* 

Ct value of Mycobacteria  

< Ct value of MTB  

MTB&NTM  

co-infection* 

Case 6 + - 
MTB : Detected 

Mycobacteria : Not detected 
MTB* 

Case 7 - + 
MTB : Not detected 

Mycobacteria : Detected 
NTM* 

Case 8 - - 
MTB : Not detected 

Mycobacteria : Not detected 
Invalid ** 

 

*  PCR reaction has been inhibited. The result is still valid 

** For invalid specimen results, pathogen nucleic acid, if present, would not be 

detectable. Process another aliquot of the original specimen and repeat the test. 

Inhibitors are often labile and specimens initially inhibitory may not be inhibited when 

repeated. If the original specimen is not available, 10~100 fold dilution of the template 

nucleic acid in distilled water may improve the PCR result.  

 

 

 

 

 



  

 
47                                                                06/2021 V3.07 

 
AnyplexTM MTB/NTM Real-time Detection (V2.0)  

 

2.2.  Application to Clinical Samples  

 

Sample1 

7500 Real-time PCR System                  Seegene Viewer 

  

Fluorophore Ct value Result 

FAM 19.66 

MTB ROX 25.14 

CY5 40.04 

 

Sample2 

7500 Real-time PCR System                  Seegene Viewer 

  

Fluorophore Ct value Result 

FAM N/A 

NTM ROX 27.14 

CY5 28.54 
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TROUBLESHOOTINGS 

 

AnyplexTM MTB/NTM Real-time Detection (V2.0) 

OBSERVATION PROBABLE CAUSES SOLUTION 

No signal The fluorophores for data 

analysis do not comply with 

the protocol 

Select the correct fluorophores for data analysis and 

export the data again. There is no need to repeat the 

test in this case. 

Incorrect setting of real-time 

thermal cycler 

Please check the thermal cycling conditions and 

repeat the test under the correct settings. 

Incorrect storage or past 

expiry date of the test kit 

Please check the storage conditions (see page 11) 

and the expiration date (refer to label) of the test kit, 

and use a new kit if possible. 

No Internal 

Control signal 

High load of specimen’s 

nucleic acid 

Please dilute (1/10~1/100) the template nucleic acid 

with RNase-free Water and repeat the test with the 

diluted nucleic acid. 

Presence of inhibitor Please dilute (1/10~1/100) the template nucleic acid 

with RNase-free Water and repeat the test with the 

diluted nucleic acid. 

Putative false 

positive or 

target signals 

observed in 

Negative Control 

Contamination Decontaminate all surfaces and instruments with 

sodium hypochlorite and ethanol. Only use filter tips 

and throughout the procedure and change tips 

between tubes. Repeat entire procedure from nucleic 

acid extraction with the new set of reagents. 

Putative false 

negative or no 

signal observed 

in Positive 

Control 

Error in specimen collection Please check the specimen collection method, and 

re-collect the specimen. 

Incorrect storage of 

specimen 

Please check the thermal cycling conditions and 

repeat the test under the correct settings. 

Error in nucleic acid 

extraction 

Please check the nucleic acid extraction procedure 

as well as nucleic acid concentration, and re-extract 

the nucleic acid. 

Error in adding nucleic acid 

to corresponding PCR tubes 

Check the sample numbers of tubes containing 

nucleic acid and make sure to add nucleic acid into 

the correct PCR tubes and carefully repeat the test if 

necessary. 

Incorrect PCR mixture Confirm that all components are added to the PCR 

mixture. (Sensitivity is compromised with pre-

composed premix,) All reagents must be 

homogenized and spun down before use. 

Presence of inhibitor Please dilute (1/10~1/100) the template nucleic acid 

with RNase-free Water and repeat the test with the 

diluted nucleic acid. 
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PERFORMANCE 

 

1.  Specificity 

 

The high specificity of Anyplex™ MTB/NTM Real-time Detection (V2.0) is ensured by the 

oligos designed specifically for the targets of interest under the set reaction conditions. 

Anyplex™ MTB/NTM Real-time Detection (V2.0) was tested for cross-reactivity to 49 different 

pathogens, and PCR amplification and detection was only identified in the specified targets. 

Organism Source No. 

Test result† 

IC 
Analyte 

MTB Mycobacteria 

Mycobacterium tuberculosis Korean isolation + + + 

Mycobacterium abscessus ATCC 19977D-5 + - + 

Mycobacterium avium (Chester) ATCC 700735 + - + 

Mycobacterium asiaticum KCTC 9503 + - + 

Mycobacterium avium subsp. avium  ATCC 25291 + - + 

Mycobacterium bovis BCG Korean isolation + + + 

Mycobacterium chelonae KCTC 9505 + - + 

Mycobacterium fallax KCTC 9508 + - + 

Mycobacterium fortuitum KCTC 1122 + - + 

Mycobacterium inracellulare KCTC 9514 + - + 

Mycobacterium kansasii KCTC 9515 + - + 

Mycobacterium neoaurum KCTC 19096 + - + 

Mycobacterium paraseoulense KCTC 19145 + - + 

Mycobacterium phlei KCTC 9087 + - + 

Mycobacterium seoulense KCTC 19146 + - + 

Mycobacterium smegmatis KCTC 9108 + - + 

Mycobacterium szulgai KCTC 9520 + - + 

Mycobacterium terrae KCTC 9614 + - + 

Mycobacterium gordonae KCTC 9513 + - + 

Mycobacterium vaccae KCTC 19087 + - + 

Mycobacterium mucogenicum KCTC 19088 + - + 

Mycobacterium massiliense KCTC 19086 + - + 
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Organism Source No. 

Test result† 

IC 
Analyte 

MTB Mycobacteria 

Nocardia asteroides KCTC 9956 + - - 

Nocardia brasiliensis KCTC 9136 + - - 

Nocardia farcinica KCTC 9958 + - - 

Nocardia otitidiscaviarum KCTC 9960 + - - 

Corynebacterium aquaticum KCTC 9098 + - - 

Corynebacterium diphtheriae KCTC 3075 + - - 

Corynebacterium flavescens KCTC 3414 + - - 

Corynebacterium glutamicum KCTC 1854 + - - 

Rhodococcus equi KCTC 1298 + - - 

Gordonia bronchialis KCTC 3076 + - - 

Gordonia sputi KCTC 3436 + - - 

Gordonia rubripertincta  ATCC 27864 + - - 

Streptococcus pneumoniae KCTC 3932 + - - 

Staphylococcus aureus  KCCM 40881 + - - 

Haemophilus parainfluenzae KCTC 5485 + - - 

Bordetella pertussis ATCC BAA-589D + - - 

Mycoplasma pneumoniae ATCC 29342 + - - 

Pseudomonas aeruginosa KCTC 1636 + - - 

Haemophilus ducreyi ATCC 700724D-5 + - - 

Candida albicans ATCC 10231D-5 + - - 

Rothia dentocariosa KCTC 19319 + - - 

Dietzia sp. KCTC 19232 + - - 

Arthrobacter oxydans KCTC 3383 + - - 

Enterococcus faecalis KCTC 2011 + - - 

Enterococcus faecium KCTC 2022 + - - 

Parvopolyspora pallida KCTC 9188 + - - 

Human gDNA Biochain D1234275 + - - 

† To prove reproducibility of the results, the experiment was repeated three times. 

 

 



  

 
51                                                                06/2021 V3.07 

 
AnyplexTM MTB/NTM Real-time Detection (V2.0)  

 

2.  Sensitivity 

 

In order to determine the sensitivity of Anyplex™ MTB/NTM Real-time Detection (V2.0), the 

test was performed with the genomic DNAs at the concentrations from 104 to 100  

copies/reaction. Detection limit for MTB and Mycobacteria was 100 copies/reaction. However, 

in the case of MTB sample that has multiple copy number of IS6110, MTB target of AnyplexTM 

MTB/NTM Real-time Detection (V2.0) can be detected up to 10 copies/rxn. 

 

3.  Reproducibility 

 

Reproducibility tests were carried out at 5 different time points in the course of 5 days by 3 

different experimenters. The same results were obtained in every test, confirming the 

reproducibility of Anyplex™ MTB/NTM Real-time Detection (V2.0). 

 

4.  Interference 

 

This test was conducted using interfering substances composed of 8 substances in order to 

confirm the performance of the AnyplexTM MTB/NTM Real-time Detection (V2.0) in the 

presence of potential interfering substances. There was no effect on the result by adding the 

substances: non-specific detection or inhibition on target amplification. Based on the results, 8 

interfering substances had no effect on AnyplexTM MTB/NTM Real-time Detection (V2.0). 

 

No. Interfering substances Concentration 

1 Mucin (bovine submaxillary gland, type I-S) 60 μg/ml 

2 Mupirocin (Antibiotic, nasal ointment) 6.6 mg/ml 

3 Tobramycin (Antibacterial, systemic) 4.0 μg/ml 

4 Oxymetazoline (Afrin Nasal Spray) 15%(v/v) 

5 Zanamivir (Anti-viral drug-Relenza) 3.3 mg/ml 

6 Oseltamivir (Anti-viral drug-Tamiflu) 25 mg/ml 

7 Isoniazid 50 μg/ml 

8 Rifampicin 25 μg/ml 
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KEY TO SYMBOLS 

 

Key to symbols used in the manual and labels 

Symbol Explanation 

 
In vitro diagnostic medical device 

 
Batch code 

 
Catalogue number 

 
Use-by date 

 
Upper limit of temperature 

 
Oligonucleotide mix for amplification and detection 

 
PCR Master Mix or Detection Mix 

 
RNase-free Water 

 
Positive Control (PC) 

 
DNA Extraction Solution 

 
Consult instructions for use 

 
Manufacturer 

 
Date of manufacture 

 
Authorized representative in the European Community 

 
Caution 

 
Contains sufficient for <n> tests 

 
Unique Device Identifier 

 
Reaction barcode for automated extraction system 
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ORDERING INFORMATION 

 

Cat. No. Product Size 

  

AnyplexTM TB series 

TB7200Y AnyplexTM MTB/NTM Real-time Detection (V2.0) 50 rxns 

TB7200X AnyplexTM MTB/NTM Real-time Detection (V2.0) 100 rxns* 

TB7202Y AnyplexTM MTB/NTMe Real-time Detection 50 rxns 

TB7202X AnyplexTM MTB/NTMe Real-time Detection 100 rxns* 

TB7203Y AnyplexTM MTB/NTM Combi 50 rxns 

TB7203X AnyplexTM MTB/NTM Combi 100 rxns* 

* For use with Microlab NIMBUS IVD, Microlab STARlet IVD, Seegene NIMBUS and Seegene 

STARlet only 

 

AllplexTM TB series 

TB10173Y Allplex™ MTB/MDR/XDRe Detection 50 rxns 

TB10174X Allplex™ MTB/MDR/XDRe Detection 100 rxns* 

TB9400Y Allplex™ MTB/MDRe Detection 50 rxns 

TB9400X Allplex™ MTB/MDRe Detection 100 rxns* 

TB9500Y Allplex™ MTB/XDRe Detection 50 rxns 

TB9500X Allplex™ MTB/XDRe Detection 100 rxns* 

* For use with Microlab NIMBUS IVD, Microlab STARlet IVD, Seegene NIMBUS and Seegene 

STARlet only 

 

AnyplexTM II TB series 

TB7500Y AnyplexTM II MTB/MDR/XDR Detection  50 rxns 

TB7301Y AnyplexTM II MTB/MDR Detection  50 rxns 

TB7302Y AnyplexTM II MTB/XDR Detection  50 rxns 

  

Seeplex® TB series   

TB2110Y Seeplex® MTB Nested ACE Detection (V2.3) 50 rxns 
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Automated extraction systems  

65415-02 Microlab NIMBUS IVD EA 

173000-075 Microlab STARlet IVD EA 

65415-03 Seegene NIMBUS EA 

67930-03 Seegene STARlet EA 

744300.4.UC384 STARMag 96 X 4 Universal Cartridge Kit 384T / 1box 

 


